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1 ABOUT DATA MANAGER (DM) 

1.1 DATA MANAGER 

With Data Manager (DM) you control MX-ONE traffic measurement tasks from a Windows-based PC 
interface. DM lets you direct MX-ONE traffic measurement processes to capture, translate, and store 
measurement data on the Traffic Manager server.  

Node performance is measured and recorded on a 15-minute interval. This data is stored in a 
temporary buffer on the MX-ONE. It is dumped to disk at midnight each day, or whenever the 
temporary buffer is full. After the transfer to disk, the temporary buffer is cleared. DM incorporates the 
following major capabilities: 

• It can be launched from Event Manager, or as a stand-alone application. 

• It connects directly or remotely to the MX-ONE and can differentiate between, and interact with 
nodes operating on MX-ONE software. 

• It can extract traffic measurement data from the MX-ONE, on a scheduled basis, on up to 21 
traffic measurement objects. 

• It dynamically converts extracted data from a proprietary hexadecimal format into decimal form 
and stores the results on selected Traffic Manager (TM) databases. 

• It can initiate and end traffic recording for all measurement objects (supervision values are not 
included). 

• It dynamically archives data during the extraction process. 

• It enables Presentation Manager to work with up to six months of traffic measurement data in the 
primary database and up to twelve months of data in the auxiliary database. 

• It can be used to update the Primary Database and setup the Auxiliary database on a per node 
basis. 

• All input messages between DM and the MX-ONE are logged in Log Files  

1.2 PRIMARY AND AUXILIARY DATABASES 

DM stores traffic measurement data in two forms on the Traffic Manager (TM) server: in the Primary 
Database and in the Auxiliary Database. However, you can only access one database at a time. 

The primary database holds up to the six months of current traffic measurement data. Accumulated 
data before the predefined primary database storage is automatically archived into monthly files if you 
run out of storage space. 

The auxiliary database can contain up to a year's worth of traffic measurement data. The auxiliary 
database provides a means to setup your own selective time range should the preferred viewing 
period be other than the current six months.  In this case however, you must perform the restoration 
process of traffic measurement data to the auxiliary database. The time range can span anywhere 
from an archived file's date up to a current file's date in the primary database.  

You have the option at TM installation to choose which node DM databases are created for, and can 
also setup the size, in months, for the primary and auxiliary databases and number of active 
measurements to store per individual node. A database upsizing function is provided in TM installation 
program to increase the database storage, including adding more nodes, more storage in months, and 
number of active measurements. You must setup the linkage to the correct database manually from 
PM Switch Node dialog box in order to view the requested data by Presentation Manager (PM). 
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1.3 DATA MANAGER HELP 

Help topics are displayed in a tri-pane Explorer View Help window where Contents, Index, and 

Search tabs appear to the left of the topic pane, and the selected topic appears on the right in the 

topic pane. The Contents tab is the default, and stays synchronized with the topic displayed in the 

topic pane. Click the Index tab to search for topics by using an index of Help subjects. Click the 
Search tab to use a full-text search for specific words or phrases. 

Tips for using Help 

• When viewing Help, you can maximize the window or resize it if you want. Click Help Topics to 
show or hide the Navigation Pane. Click to go to the next topic in the browse sequence. Click

to go to the previous topic in the browse sequence. The Options menu provides additional 
display controls. 

• Click the Print button to print the current topic. To print the entire help file you need to have 
Microsoft Word or Word Viewer installed on the PC. Word Viewer is a free download from 
Microsoft’s web site. 

• To print the entire help file: 

1. Right-click on the DMHelp.doc file in the DM\HELP directory under MSP_C or MSP_S. 

2. Click Print on the pop-up menu. 

• Click the Help buttons in dialog boxes to display information on the box's control elements. 
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2 DATA MANAGER INTERFACE 

2.1 MAIN WINDOW 

After you log on to Data Manager, the main window appears. DM main window consists of a menu 
bar, measurements node selection, toolbar buttons, and a status bar. 

 

2.2 APPLICATION MENU 

TO SELECT 

Logon as a different user or change to another server. Change Current User... 

Replace your current access security password with a 
new one. 

Change Password... 

Select and connect to an individual traffic measurement 
node. 

Connect... 

End your connection to the current node (shown in the 
node selection window) and return to the main window. 

Disconnect 

Customize your data communications parameters, adjust 
MX-ONE connect delay, and character transmission 
timing. 

Communications...  

Review, modify, and delete DM/MX-ONE log files. Log Files...  

Configure basic DM operating parameters, save 
workspace on exit, create feedback logs, on-line/off-line 
operating mode, and polling time and server selection for 
automatic data extraction. 

Properties... 

Manually extract and update the Primary database, a task 
that is normally performed automatically.   

Update Primary Database...  
 

Store current traffic data and/or archived traffic data into 
auxiliary database. 

Setup Auxiliary Database...  

End your DM session. Exit 
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2.3 VIEW MENU 

TO SELECT 

Display and hide the toolbar. Toolbar 

Display and hide the status bar. Status Bar 

2.4 MEASUREMENT MENU 

TO SELECT 

Initiate a New Measurement. Initiate… 

Terminate the selected measurement. End 

 

2.5 WINDOW MENU 

TO SELECT 

Hide and display the traffic measurement command feedback 
window. 

Feedback Window 

Arrange open System Information and Feedback windows in 
stepped, overlapping fashion, with the selected window on top. 

Cascade 
Use for sequential viewing. 

Arrange open System Information and Feedback windows in 
adjacent, non-overlapping fashion. 

Tile 
Use for simultaneous viewing. 

2.6 HELP MENU 

TO SELECT 

Open the Help Topics window. Contents and Index 

Open the application's About box. About Data Manager 

2.7 TOOLBAR 

You can use the toolbar to connect to measurement nodes and to start and stop measurements. 
Located just below the menu bar, the toolbar consists of a drop-down node selection window and a 
pair of buttons you can use to initiate and end measurements. 

2.7.1 NODE SELECTION DROP-DOWN LIST 

Use the drop-down list on the toolbar to view a list of all available measurement nodes for which you 
have access authorization. Connect to the node you want by clicking its entry in the drop-down list. 
You can also select Connect... in the Application menu to connect to available nodes. 

2.7.2 INITIATE AND END MEASUREMENTS BUTTONS 

After you connect to a node you can modify existing measurement assignments or create new ones.  

Click the Initiate  and End  buttons to the right of the Node Selection window to open the 
Initiate New Measurement dialog box, or to end the selected measurement. 

 
Note! Online operation is required for access to these buttons. See Properties... in the 
Application menu. 
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2.8 STATUS BAR 

The Status Bar provides DM status and Help for each menu item, whether enabled or disabled. The 
left side of the status bar displays Help messages and the rightmost portion displays if you are logged 
on or off, or connected in offline or online modes. 

2.9 SYSTEM INFORMATION WINDOW 

When you successfully connect to an MX-ONE measurement node, the node information appears in 
the System Information window. The System Information window consists of a directory tree that 
serves as a display control, and a display area for available measurement objects and active 
measurement entries. 

2.9.1 DIRECTORY TREE PANEL 

The System Information panel displays a directory tree that allows you to access measurement 
objects. The folders represent the MX-ONE call management Measurement Objects monitored by 
Data Manager. The System Information directory tree lists the connected measurement node (root), 
the Active Measurements category, and individual measurement groupings. 

2.9.2 SPREADSHEET PANEL 

Identification details are displayed for each available measurement object. These details are provided 
for both individual and grouped objects.  

To View Measurement Objects 

1. Double-click the directory tree folder (measurement object category) you want to examine. 

2. For long lists, arrange measurement objects alphabetically or numerically using the sort control 
buttons at the top of your column of interest. These sort controls enable you to arrange 
measurement objects in ascending order, based on the numeric and/or text sequences under the 
selected column header. 

2.10 MX-ONE FEEDBACK WINDOW 

As part of the main DM interface, the MX-ONE Feedback window allows you to monitor traffic 
measurement command and response dialog between DM and the MX-ONE.  

Select Feedback Window in the Window menu to open the command feedback window. 
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3 CONFIGURATION 

3.1 COMMUNICATIONS CONFIGURATION 

Before connecting to a measurement node, you need to select communication type and setup 
parameters to comply with your selection. For technical help with this process, contact your System 
Administrator. Selecting Communications... from the Application menu opens the Communications 
Setup dialog box, where you can use the following tabs to configure your communications. 

3.1.1 CONNECTION TAB 

OPTIONS EXPLANATION 

Type Specifies connection type for the selected node. The controls that are 
active in the three tabs are dependent on the type selected. 

3.1.2 FLOW CONTROL TAB 

OPTIONS EXPLANATION 

Command Response 
Time-out 

Specifies connection type for the selected node. The controls that are active in 
the three tabs are dependent on the type selected. 

Connection Time-Out Amount of time (in seconds) allowed to complete the logon process with the 
selected MX-ONE node. This interval includes the time required to send out 
both an MX-ONE initialization string and password. 

Inter-Character Delay Amount of time (in milliseconds) to delay between each character sent to the 
MX-ONE. 

1. Set the communications parameters using the drop-down lists in the Properties area. 

2. If desired, check the Parity Check on Incoming Data checkbox to activate incoming parity 
checks. 

3. Click the Flow Control tab. 

4. Enter the number of seconds (60-300) in the Command Response Time-Out edit box you want 
the application to wait for a command response from the     MX-ONE before timing out.  

5. Enter the number of seconds (15-30) in the Connection Time-Out edit box you want the 
application to wait when attempting to connect to the MX-ONE before timing out. 

6. Choose an Inter-Character Delay value (in milliseconds) from the corresponding drop-down list. 
When sending commands to the MX-ONE it is necessary to provide some delay between 
characters. Normally, the delay for a direct connection should be longer than that of a ssh 
connection. Increase the delay if you are getting error messages when sending commands to the 
MX-ONE, for example, "Unknown Command" or "Bad Parameter." 

7. Click Apply to save your settings. 

8. Click Close to return to the main window. 

3.2 SSH  CONNECTION 

To Configure a SSH Connection: 

1. Open the Communications Setup dialog box by selecting Communications... from the 
Application menu. 

2. Select the appropriate node from the Node drop-down list. 

3. Click the Connection tab. 
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4. Select SSH from the Type drop-down list. 

5. To setup or modify the Default Attempt List, open the Define Default Attempt Connection List 
dialog box by clicking the Define List... button.  

-or- 

6. To setup or modify a Temporary Attempt List, check the Use Temporary List checkbox and open 
the Define Temporary Attempt Connection List dialog box by clicking the Define List... button.  

 
Note! If the list is empty, you need to use the Node Setup feature of the MX-ONE Support utility to setup 
the SSH Communication Server connection for the node selected in Step 2. 

7. Click Apply to save the SSH connection list setup. 

8. Click Close to close the dialog box and return to the main window. 

3.2.1 DEFAULT ATTEMPT CONNECTION LIST 

1. Highlight the entry you want to add in the All Configured List. 

2. Add it to the Default Attempt List by clicking the Add  button. 

3. Repeat Steps 1 and 2 until you have completed building the list. 

4. Remove any entries you don’t want in the Default Attempt List by highlighting them and clicking 
the Remove  button. 

5. Click OK to close the dialog box and return to the Communications Setup dialog box. 

3.2.2 TEMPORARY ATTEMPT CONNECTION LIST 

1. Highlight the entry you want to add in the Default Attempt List. 

2. Add it to the Temporary Attempt List by clicking the Add  button. 

3. Repeat Steps 1 and 2 until you have completed building the list. 

4. Remove any entries you don’t want in the Temporary Attempt List by highlighting them and 
clicking the Remove  button. 

5. Click OK to close the dialog box and return to the Communications Setup dialog box. 

3.3 CONFIGURE PROPERTIES 

To Configure Properties: 

1. Open the Properties dialog box by selecting Properties... from the Application menu. 

2. Check Save Workspace on Exit to preserve the location and size of the DM main menus, system 
information, and feedback windows. 

3. Check Interactive Log to activate feedback file logging of the DM/MX-ONE initiate/end 
measurement command and response dialog. 

4. Check Offline Mode to operate without connecting to an MX-ONE. Use this option when you only 
need to access traffic measurement information on the local TM SQL Server. 

5. Use the Polling Time edit control to specify when you want polling to begin. Even though you can 
only set polling time at the beginning of the hour, it actually begins at 30 minutes past the hour. 

6. Select the servers you want to poll in the Do not Extract From list box and click the  button 
to move them to the Extract From list box. 

7. Select the servers you do not want to poll in the Extract From list box and click the  button 
to move them to the Do not Extract From list box. 
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8. Select OK to save your settings and close the Properties dialog box. 

Before connecting to a measurement node, you need to configure your general operating profile 
and, in particular, whether or not you intend to operate in online or off-line mode. The default is 
Online. 
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4 TRAFFIC MEASUREMENTS 

4.1 NODE CONNECTION 

Before you begin traffic measurements you must connect to the MX-ONE Node you want to measure. 

 
Note! If the Node is MX-ONE, before connecting to node follow steps: 

1. Login to switch as root administrator 

2. Open mdsh.conf from “/etc/opt.eri_sn “ using vi editor 

3. Search for UNIX word (e.g. /Unix) 

4. Add entry as unix:hexdump=0, if not existing 

5. Save and close mdsh.conf 

6. Logoff and login again 

7. Go to mdsh prompt and check whether command hexdump is available 

To connect using the toolbar: 

1. Click the down-arrow button on the toolbar’s drop-down list. 

2. From the drop-down list, select the node you want to access. When the connection is established, 
the System Information display appears. 

To connect using the Application menu: 

1. Open the Connect dialog box by selecting Connect on the Application menu. 

2. From the Connect To list, select the node you want to access.  

3. Click OK. When the connection is established, the System Information display appears. 

4.2 INITIATING AND ENDING TRAFFIC MEASUREMENTS 

Once you have connected to an MX-ONE measurement node in ONLINE mode, you can perform 
initiate and end actions on all available measurement objects. The System Information window 
displays which management resources are available for extracting measurements for the connected 
MX-ONE node. 

To Initiate a new measurement, data path has to be established in MX-ONE node by using the 
following command: 

TRDPI:PATH="/var/opt/eri_sn/traffic_recording/";  

This should be done manually. 

 
Warning! To preserve the integrity of your traffic measurement databases, use only Data Manager to 
initiate and end all traffic measurements. Do not use direct commands. If you use commands, the active 
measurement will not be re-synchronized until the next data extraction. 

To Initiate Traffic Measurements: 

1. Open the Initiate New Measurement dialog box by selecting Initiate on the Measurement menu, 

clicking the Initiates Measurements button  on the toolbar, or pressing the Insert key. 

2. Select a measurement object from the Object drop-down list (Data Extension, Common Bell 
Group, Operator Individual, etc.).  

 Note! Selecting the drop-down list option EXTENS – Voice extension only records the traffic for Analog 
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and Digital extensions. To record IP traffic, initiate the measurement (IPXBRD – IP Network Interface). 

3. Select a parameter type from the Type drop-down list. The items in this drop-down list are 
dependent on the object selected in the Object drop-down list. 

4. In the Value entry box, enter or drag-and-drop (from the System Information panel) the 
appropriate value for the measurement object and parameter type you selected in steps 2 and 3. 

5. Specify a date range for DateRange 1 (mm/dd/yyyy). This defines the initial start and end dates 
for the measurement. Optionally, you can select an additional measurement period using 
DateRange 2 (mm/dd/yyyy). You can clear this field by clicking Reset. 

6. Specify the daily time interval for beginning and ending the measurement in the TimeRange 
(hh:mm) option boxes. 

7. Enter a comment if you like in the Memo entry box. 

8. Click Initiate to activate the measurement. You can clear all fields and start over by clicking the 
Clear button. 

9. Repeat steps 2 through 8 for additional measurements. 

10. After initiating the last measurement, click the Close button. 

To End MX-ONE Traffic Measurements: 

1. Double-click the Active Measurements folder to view the active measurements for the connected 
node. 

2. Scroll to and select the measurement entry you want to terminate. 

3. Click the End button  on the toolbar, select End from the Measurement menu, or press the 
Delete key. 

4. When the confirmation dialog box appears, select Yes. 

4.3 LOG FILES 

Data Manager communicates with the MX-ONE using commands to perform measurement tasks. This 
command interaction is normally transparent. Nevertheless, DM records all automatic and manual 
command interaction with the MX-ONE. DM maintains two types of logs you can use to review and 
trace command interaction. 

LOGGING TYPE EXPLANATION 

Interactive Log The Interactive Log is maintained in two files, the Command Log file and the 
Feedback Log file. Records of initiate and end commands issued to the MX-
ONE by Data Manager are logged in the Command Log file. Records or the 
responses to MX-ONE  initiate and end commands are logged in the Feedback 
Log file. The Interactive Log checkbox in the Properties dialog box 
enables/disables interactive logging. 

Batch Log Records all actions that occur during both automatic and manual traffic 
measurement data extraction operations. The Batch Log is automatically 
activated. 

New log files are generated on a daily basis and are overwritten after one month. That is, the newest 
daily log file overwrites the oldest of thirty or thirty-one files (depending on the month in question). 
Command and Feedback Log files are node-oriented and are coordinated with the measurement 
records for a given node. Batch Logs are node-independent. 

To view logs: 

1. For Interactive Log files, connect to a node. That is, select Connect on the Application menu and 
choose a node. 

2. Select Log Files... on the Application menu. 
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3. Display the Type of File drop-down list and select the desired file type. 

4. Select the file you wish to view from the Files list. 

5. Click Edit to open the highlighted file in the Files list with Windows Notepad. 

6. When you finish viewing the file, select Exit from the Notepad File menu. 

7. Return to step 3 to view another file, or select Close to return to the main window.  

In ONLINE mode (connected to an MX-ONE) you view transaction records in real-time as they scroll 
into the feedback window. 

 



 

MX-ONE Traffic Manager 1.4 – Data Manager 

 

33/1553-ANF90115 Uen B1 2018-04-25  12 

 

 

5 DATA EXTRACTION 

5.1 EXTRACTING TRAFFIC MEASUREMENT DATA 

Under normal circumstances, Performance Data Manager retrieves MX-ONE traffic measurements 
automatically on a daily (nightly) basis. DM downloads and translates traffic measurement records 
from hexadecimal to non-proprietary ASCII format and uploads and stores them in the TM SQL Server 
database. This overall process is referred to as Data Extraction. Data can be extracted in both 
automatic and manual mode. DM extracts traffic measurement data from the MX-ONE Service Node  
using commands. 

 
Note! You do not need to understand commands to use Performance Data Manager. However, some 
knowledge of commands may be useful when using the feedback logs to trace DM/MX-ONE dialog . 

Extracting amounts of data that exceed the disk space configured for the primary TM server traffic 
measurement database causes the overflow to be extracted to archival files. For example, if TM traffic 
measurement disk space has been allocated for 3 months of data, and you attempt to manually 
extract 6 months of data, the first 3 month's data gets placed in three separate monthly files, and the 
most recent 3 month's data are stored in the primary database. 

5.2 DATA EXTRACTION TIME ESTIMATES 

 Extraction time is affected by LAN factors such as server processing capacity and user load. 

WORST CASE ESTIMATES 

Daily traffic measurement Volume 50 KB 

Extraction Time 20 min. 

6-Month Volume 9 MB 

Extraction Time 60 hr. (2.5 days) 

 
Note! The extraction process involves downloading unprocessed MX-ONE traffic measurement data, 
performing the conversion, and uploading to the TM SQL server. 

5.3 INITIAL RETROACTIVE EXTRACTION 

The first automatic data extraction after installation attempts to retrieve traffic measurement data 
existing on the HDU for the currently active measurements in the MX-ONE and stores them into the 
TM database. The first extraction process, therefore, may require more time to execute. To provide 
immediate access to any measurement data that may be available at the time of installation, DM 
automatically performs a comprehensive automatic extraction, whether scheduled or not, the following 
morning at 00:30 (12:30 A.M.). To cancel this process, see Canceling Automatic Extraction.  

5.3.1 DETERMINING HOW MUCH DATA WILL BE EXTRACTED 

For the first extraction after a DM installation, or if the Primary database is empty, DM determines the 
size of the Primary database and sets the extraction start data to the first day of the first month for 
which any data is available, regardless of the current date. For example, if the Primary database is 6 
months deep and today's date is December 12th, 2010, the start date is set to June 1st, 2010 and the 
end date to December 11th, 2010. 

DM's objective is to extract as much data as possible from the MX-ONE HDU and into the TM SQL 
server database. If there is not enough disk storage defined in the TM Server, the most recent data is 
stored in the Primary database with prior data stored as files to be viewed as Auxiliary database 
information. Your disk space requirements for the Primary and Auxiliary databases are configured 
during the TM installation process. 
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After the initial data extraction, the Update Primary Database dialog box shows the new extraction 
start date as the oldest date for which no data has been extracted (i.e., last day plus 1 for which the 
pervious extraction was performed). For example, take the case above where data has been extracted 
through December 11, 2010, and no data extraction has been performed since that date. If today's 
date is February 12th, 2011 the Update Primary Database dialog box shows the start date as 
December 12th, 2010, and the end date as February 11th, 2011. 

DM does not allow you to recover data skipped by a previous manual extraction. For example, using 
the case above, if the prior extraction start was set to January 1st, 2011, data from December 12th, 
2010 through December 31st, 2010 cannot be retrieved. In summary, once data extraction has been 
performed, the database start and end date range is adjusted forward and fixed to resume following 
the last date included in the previous extraction. 

5.4 REGISTRY SETTINGS 

5.4.1 POLLING START TIME 

The data polling begins at 00:00 and actual download starts at 00:30 by default. The polling begin time 
can be changed with the Polling Time spin-box in the Properties dialog box. The actual download will 
start 30 minutes after the defined polling time.  

5.4.2 SKIP NODES FOR POLLING 

All nodes on the server will be polled by default. However, polling selected nodes can also be setup 
through registry settings. 

To setup nodes to skip when polling: 

1. Create a key with TM Server machine name under 
HKEY_LOCAL_MACHINE/SOFTWARE/Ericsson/PMG/  

Example: HKEY_LOCAL_MACHINE/SOFTWARE/Ericsson/PMG/MSP_SERVER1 

2. Add a string SkipSites with the nodes you want to skip separated by commas (",") under the key 

created in Step 1 and end with a comma (","). 
Example: If there are five nodes and only node 2 and 4 should be polled, set the registry string to: 

1,3,5, (make sure you end with a comma ",")  

5.4.3 EXTEND POLLING TIME 

The DM data polling routine will poll data for six hours starting from the BatchTime setting. You can 
setup a registry string to extend the polling time. The polling time should be set between six to twelve 
hours. If no setting is present, or the setting is less than 6, polling time defaults to six hours. If setting 
is greater than 12, it will be treated as 12 hour polling time. The registry is 
\\HKEY_LOCAL_MACHINE\Software\Ericsson\PMG\BatchLength. 

5.5 AUTOMATIC EXTRACTION 

Automatic data extraction refers to Data Manager’s downloading, translating, and transferring traffic 
measurement data to the TM database server on a daily basis. The default settings for this task are for 
polling to begin each morning at 00:00 (midnight) and the download at 00:30. The default time can be 
changed in the Properties dialog box. 

The polling window is six hours in length. After six hours polling will finish on the server but will not 
continue on the next server. If polling cannot be completed in six hours with one server, you should 
configure your system to poll with additional servers or clients. 

If, for any reason, DM fails to extract traffic measurement data from the MX-ONE Service Node at 30 
minutes past midnight, it repeats trying to extract two more times, with each try at half-hour intervals. 

There are two ways to have a data extraction process started automatically at the pre-defined time. 
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1. Leave DM running on a client and the data extraction process will start at a pre-defined time 
automatically. 

2. Schedule DM via the RDS scheduler to start as a batch job on the server. It must be scheduled 
prior to the pre-defined data extraction time. The data extraction process will then start 
automatically when the time arrives. DM scheduling can be set during the installation procedure. 

5.6 CANCELING AUTOMATIC EXTRACTION 

If a significant amount of traffic measurement data has been accumulated, the automatic data 
extraction process may require a substantial amount of time or may consume too much database disk 
space. See the Data Extraction Time Estimates for calculation guidelines. If this is the case, use the 
following procedure to preempt execution of DM’s automatic extraction routine. DM extracts MX-ONE 
traffic measurement records based on the polling time set in the Properties dialog box. 

To Cancel Automatic Data Extraction: 

1. Resolve the problem that is causing the need to abort the process. 

2. Before automatic extraction processing begins, a countdown warning box (Alert) is displayed. 

3. Click the Abort button before the countdown expires. 

 
Note! To prevent a re-attempt of the extraction, disable the automatic extraction feature in the Properties 
dialog box. That is, select Properties from the Application menu to access the automatic extraction 
control. This procedure applies to any automatic extraction operation, not only the post-installation initial 
extraction. 

5.7 HANDLING EXTRACTION FAILURES 

If Data Manager fails to successfully perform the scheduled extraction, it retries twice, at 30-minute 
intervals, after all other scheduled extractions (if any) are completed. Should this process fail you can 
resort to Manual Data Extraction. 

5.8 MANUAL DATA EXTRACTION 

Should the automatic data extraction fail, you can resort to manual intervention to control the 
extraction process. DM allows you to select a desired start-end data range for extraction to the TM 
database server. Manual extraction enables you to poll all records accumulated since the last 
successful automatic or manual extraction. The Update Primary Database dialog box displays the 
appropriate recommended start-end date range when opened. 

To Update the Primary Database: 

1. Open the Update Primary Database dialog box by selecting Update Primary Database... on the 
Application menu. 

2. Select node and date ranges (advance start date if necessary) and click the Right Arrow  
button after each selection.   

3. Select OK to begin the extraction process. The Update Primary Database dialog box displays 
extraction progress. DM will extract the specified range of measurement records. When the 
process completes, the Data Manager message box will display the results. 

4. Select OK to close the dialog box and return to the main window. 

 
Caution! Your first extraction determines the earliest available data (chronologically) for all subsequent 
Primary Database updates. That is, after the first extraction, DM extracts and appends newer data, but 
does not extract or insert older measurements. 



 

MX-ONE Traffic Manager 1.4 – Data Manager 

 

33/1553-ANF90115 Uen B1 2018-04-25  15 

 

 

5.9 RETRIEVING ARCHIVED RECORDS 

Data Manager provides a dialog box for setting up an auxiliary database for retrieving archived traffic 
measurement data. You can specify any contiguous twelve-month period, ranging from the oldest 
archived records through the last date of previous month stored in the Primary database. Overall, you 
can analyze and report on up to eighteen months of performance records when you consider a fully 
updated primary database with six months of data and the updated auxiliary database with a prior 
twelve months of archived records. The auxiliary and primary databases must be viewed separately. 

 
Note! Management and maintenance of these databases must be assigned to individuals with 
secure LAN server administrative authority. 

To Setup the Auxiliary Database 

1. Open the Setup Auxiliary Database dialog box by selecting Setup Auxiliary Database... from the 
Application menu. 

2. Select the desired Node and DateRange, then click the Right Arrow  button when each entry 
is complete. Repeat this process for each desired node. 

3. Select OK to begin the scan. 

The Scan Archival Files dialog box is opened. When DM’s scan of the archived files is complete, the 
Setup Auxiliary Database dialog is opened and remains in place until the extraction process is 
complete. During the extraction process, DM first deletes records outside the date ranges you 
selected. Finally, new records are inserted. Auxiliary database setup is complete when the meter on 
the Setup Auxiliary Database dialog box reaches 100% and the dialog box is closed. 

5.10 SYSTEM TIME AND DATE SETTINGS 

There are several circumstances where time and date settings need to be adjusted. These include: 

• Forward Time Adjustment (e.g. Daylight Savings Time - Spring) 

• Backward Time Adjustment (e.g. Standard Time - Fall) 

• Forward Date Adjustment (e.g. Leap Year) 

• Forward/Backward Time-Date Synchronization 

 
Caution! Do not change MX-ONE time-date settings while traffic recording is in progress. To do 
so can result in erroneous traffic measurement data readings by both DM and PM. 

5.10.1 FORWARD TIME ADJUSTMENT 

When the MX-ONE system clock is set forward, as in the case of Daylight Savings Time (Spring), 
traffic measurements for the skipped hour are not saved to disk. DM therefore interprets missing 
information as absence of traffic activity and transmits this missing information to the TM database 
server. 

5.10.2 BACKWARD TIME ADJUSTMENT 

When the MX-ONE system clock is set backward, as in the case of Standard Time (Fall), traffic 
measurements for the repeated hour are duplicated on disk. Therefore, DM is only able to extract and 
translate the latest measurements for the repeated hour. 

5.10.3 FORWARD DATE ADJUSTMENT 

In the case of Leap Year, the MX-ONE system’s perpetual calendar adjusts automatically and correct 
traffic measurement data is written to disk. Therefore, DM extracts and translates complete traffic 
measurements for Leap Year transitions. 
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5.10.4 FORWARD/BACKWARD TIME-DATE SYNCHRONIZATION 

You need to keep time and date settings coordinated between the DM PC, the   MX-ONE, and the TM 
database server. When coordinating adjustments, keep in mind that you need to make sure all active 
MX-ONE traffic measurements are terminated before manually changing time-date settings in either 
direction. 

 
 
 
 


